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Support

Please visit the HP OpenView web site at:

http://www.managementsoftware.hp.com/ 

This site provides contact information and details about the products, services, and support that HP 
OpenView offers. To reach the Support site, click Support. The Support site provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valuable support customer, 
you can benefit by using the support site to:

• Search for documents of interest

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Join online discussions with other software customers

• Research and register for software training

Most of the support areas require you to register as an HP Passport user and log in. You may also require a 
support contract.

To find more information about access levels, go to the following URL:

http://support.openview.hp.com/access_level.jsp 

To register for an HP Passport ID, go to:

https://passport.hp.com/hpp2/newuser.do
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Chapter 1
Overview

Frame relay networks eliminate link-layer error checking by assigning responsibility for 
packet retransmission to higher level protocols. To avoid congestion the nodes in a frame relay 
network forward flow-control alerts to neighboring nodes. If flow-control alerts do not prevent 
congestion, nodes can alter the discard-eligibility (DE) status of individual frames.

This chapter covers the following topics:

• Folders and reports

• Data collection

• Prerequisites

• Integration with NNM

• Threshold traps and alarms; default threshold values

• Ways to customize reports

• Version history

• Sources for additional information

Folders and Reports

When you install version 4.0 of the Frame Relay Report Pack, Package Manager creates a 
parent directory and two child directories. The parent directory is FrameRelay_Service. The 
child directories are: 

• Port

• PVC

Reports in the port folder display data for the logical port on the device, which often equates to 
an entry in the MIB-II ifTable. Reports in the port folder contain the following statistics:

• In utilization/out utilization

• Number of frames sent/number of frames received

• Number of octets sent/number of octets received

• Number of frames discarded 

• Number of frames discarded due to errors
7



Folders and Reports
Reports in the PVC folder reach a lower level of detail, showing information for PVC 
endpoints. Reports in the PVC folder contain the following statistics:

• Ingress utilization/egress utilization

• Number of committed-burst frames 

• Number of excess-burst frames 

• Number of Discard Eligible (DE) frames 

• Number of frames indicating forward congestion (FECN)

• Number of frames indicating backward congestion (BECN)

The Frame Relay Report Pack contains the following types of reports:

Availability. Highlights ports and PVCs reporting low availability for yesterday. The 
selection table is followed by hourly analysis of availability for a selected port or PVC.

Capacity Planning. Highlights Ports and PVCs that are expected to be either underutilized 
or overutilized 30 days from now.

Executive Summary/Executive Summary by Region. A comparison of baseline 
performance to F30 for all ports or all PVCs, followed by monthly, daily, and hourly analysis of 
aggregated volume and aggregated errors. The report begins with either a list of customers or 
a list of regions.

Forecast. Highlights ports and PVCs that are expected to have the highest utilization levels 
30 days into the future. Rate of growth is calculated by dividing the F30 value by the baseline 
average. The baseline average is an average of daily busy hour values.

Hot Spots. Highlights ports and PVCs with high exceptions. The PVC version looks at 
utilization, congestion, and GOS exceptions; the port version looks at utilization, error, and 
discard exceptions. 

PVC Configuration Problems. A list of PVCs that have invalid (missing or incorrect) CIR 
values or invalid PVC Id values. Any PVC with a CIR value of NULL or 0 will appear in this 
report.

QuickView: Near Real Time, Daily, Monthly. A list of overutilized ports and PVCs, 
followed by analysis of average and peak utilization for a specific port or PVC. The NRT 
version provides a list of the most utilized ports and PVCs based on data collected (and 
averaged) over the last six hours. The selection table is followed by (1) analysis of peak and 
average utilization, (2) analysis of errors and discards, and (3) Grade of Service.

Round Trip Delay. One version only of this report, for PVCs. Provides a list of PVCs 
experiencing the longest round trip delay. Not all datapipes collect this metric. See the release 
statement for the datapipe for details.

Snapshot: Near Real Time, Daily, Monthly. Same as the QuickView, but limited in scope 
to specific ports or PVCs that you select in advance before the report opens.

Top Ten. Identifies PVC endpoints and ports experiencing high utilization. Consists of two 
tables. The top table looks at yesterday’s performance; the bottom table looks at performance 
for the previous 30 days.

Data Collection

Installing at least one datapipe for Frame Relay 4.0 is mandatory. You may install any of the 
following datapipes:
8



Chapter 1
• Frame Relay CPE Datapipe (for MIBs compliant with RFC2115)

• Ascend Frame Relay Datapipe (Lucent)

• Newbridge Frame Relay Datapipe (Alcatel)

• Stratacom Frame Relay Datapipe (Cisco WAN) 

The datapipe for Newbridge and the datapipe for Stratacom require pre-processing. If you 
intend to poll Newbridge devices, installing the Newbridge Preprocessor is mandatory. If you 
intend to poll Stratacom devices, installing the Stratacom Preprocessor is mandatory. 

The Frame Relay CPE Datapipe polls the following MIBs:

• RFC 1315

• Cisco Frame Relay MIB

• Nortel/Bay FRSW MIB

• Nortel/Bay WAN780 MIB

The Frame Relay CPE Datapipe can be configured. For details about options for data filtering, 
property provisioning, logging, and polling policies, refer to the Frame Relay CPE Datapipe 
4.0 User Guide.

Prerequisites for Frame Relay 4.0

The Interface Reporting Report Pack is a prerequisite for Frame Relay 4.0. If you are not 
already using Interface Reporting, you will need to install Interface Reporting when you 
install Frame Relay 4.0. When you install Interface Reporting, you are not required to install 
the Interface Reporting ifEntry Datapipe. However, if you want to use the reports in Interface 
Reporting, then you must install the Interface Reporting ifEntry Datapipe.

The dependency on Interface Reporting is related to property table created by Interface 
Reporting. The property table is KIRDevPorts. This table is populated by collections 
associated with Interface Reporting and collections associated with the Frame Relay Report 
Pack. The data in this table can be modified by importing properties or by working with 
change forms. 

Integration with NNM

You can strengthen your diagnostic ability by integrating NNM and OVPI. Integrating NNM 
and OVPI allows you to access the reports listed above directly from NNM. For details about 
installing the integration module refer to the NNM/Performance Insight Integration Module 
2.0 User Guide.

If NNM and OVPI are integrated, you can investigate interfaces monitored by the Frame 
Relay Report Pack without leaving NNM. The reports listed above will appear in the Report 
Launchpad window. You can open the Report Launchpad window from multiple NNM 
interfaces, including:

• NNM maps (ovw) 

• Home Base Dynamic Views

• NNM alarm browser
9



Integration with NNM
Threshold Traps and NNM Alarms

You can enhance integration with NNM further by installing the thresholds sub-package that 
comes with Frame Relay. The name of this sub-package is FrameRelay_Service_Thresholds. 
You will see it when you run Package Manager. Installing FrameRelay_Service_Thresholds 
configures OVPI to:

• Monitor the database for threshold breach conditions

• Monitor the database for threshold clear conditions

• Send threshold traps (breach and clear) to a network management station

If NNM and OVPI are integrated, NNM is the default destination for threshold traps. 
Threshold traps delivered to NNM become alarms in the NNM alarm browser. By selecting 
the alarm you can launch a Near Real Time report.

Default Thresholds for Exceptions

If you install the thresholds sub-package, no intervention on your part is necessary to enable 
the threshold defaults explained in the following table.  

Exception Default Value Description Severity

DE in Deviation 10% above 
yesterday’s 
average

An exception occurs when the 
percentage of packets marked Discard 
Eligible (DE) is 10% above yesterday’s 
average DE ratio.

Medium

DE out Deviation 10% above 
yesterday’s 
average

An exception occurs when the 
percentage of packets marked Discard 
Eligible (DE) is 10% above yesterday’s 
average DE ratio.

Medium

FECN% Inbound 10% An exception occurs when the ratio of 
inbound packets marked FECN to the 
total number of packets is equal to or 
greater than 10%.

Medium

FECN% Outbound 10% An exception occurs when the ratio of 
outbound packets marked FECN to 
the total number of packets is equal to 
or greater than 10%.

Medium

BECN% Inbound 10% An exception occurs when the ratio of 
inbound packets marked BECN to the 
total number of packets is equal to or 
greater than 10%.

Medium

BECN% Outbound 10% An exception occurs when the ratio of 
outbound packets marked BECN to 
the total number of packets is equal to 
or greater than 10%.

Medium
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Chapter 1
The defaults in the preceding table can be modified using the PVC Endpoint Configuration 
form. For details, see Chapter 5, Updating Property Values.

Ways to Customize Reports 

You can customize reports by doing the following:

• Adding property values to PVCs

• Applying group filters to the database

• Applying constraints to reports

• Changing view options for tables and graphs

For details about adding property values, and modifying property values by using a change 
form or the property import file, see Chapter 5, Updating Property Values. For details about 
view options for tables and graphs, see Chapter 13, Editing Tables and Graphs.

Group Filters

If you want to share your reports with customers, you must configure OVPI to produce 
customer-specific reports. Here is an overview of the steps involved:

• Use Common Property Tables to add customers and locations

• Create a group account for all of the users affiliated with each customer

• Create a group filter for each group account

For more information about creating filters for group accounts, refer to the Performance 
Insight Administration Guide. 

Applying Constraints

When you edit a parameter, you apply a constraint. The constraint eliminates data you are 
not interested in seeing. If you edit the Customer Name parameter, data for all customers 
except the customer you typed in the Customer Name field will drop from the report. If you 
edit the Device Name parameter, data for all devices except the device you typed in the Device 
Name field will drop from the report. 

You can apply multiple constraints at once. Frame Relay 4.0 supports the following 
parameters: 

• Customer Name

• Customer ID

• Location Name

• Location ID

• Device Name

• Port

• Dlci
11



Version History
• Make

• Model

If you are using the Web Access Server to view reports, edit parameters by clicking the Edit 
Parameters icon at the bottom right-hand corner of the report. When the Edit Parameters 
window opens, enter the constraint in the field and click Submit. 

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the 
Modify Parameter Values window opens, click the Current Value field. Type a new value and 
click OK.

Version History

The following table outlines recent enhancements to the Frame Relay Report Pack.

Version RNS Version Features/Enhancements

1.0 RNS 1.0 - January 2002 Sybase support
datapipes:
• Frame Relay CPE Datapipe 1.0
• Ascend Frame Relay Datapipe 1.0
• Newbridge Frame Relay Datapipe 1.0
• Stratacom FR Datapipe 1.0 (Cisco WAN) 

2.0 RNS 2.0 - January 2003 Version 1.0-to-2.0 upgrade package

2.0 RNS 3.0 - May 2003 No changes

3.0 RNS 4.0 - October 2003 OVPI Object Manager support
Version 2.0-to-3.0 upgrade package
new change forms:
• Change PVC Endpoint Customer
• Change PVC Endpoint Location
• Change PVC Endpoint Description
• Change PVC Endpoint Configuration

4.0 RNS 5.0 - April 2004 Oracle support
Version 3.0-to-4.0 upgrade package

4.0 RNS 6.0 - August 2004 No changes

4.0 RNS 7.0 - November 2004 No changes
12
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Sources for Additional Information

This manual includes samples of some reports of the reports in Frame Relay 4.0. The demo 
package that comes with Frame Relay 4.0 contains a sample of every report in the package. If 
you have access to the demo package and you want to know what fully-populated reports look 
like, install the demo package. Like real reports, demo reports are interactive. Unlike real 
reports, demo reports are static.

The following documents are related to this manual: 

• Frame Relay CPE Datapipe 4.0 User Guide

• Interface Discovery Datapipe 2.1 User Guide 

• Newbridge Preprocessor 3.0 User Guide 

• NNM / Performance Insight Integration Module 2.0 User Guide 

• Stratacom Preprocessor 3.0 User Guide

• Thresholds Module 5.0 User Guide 

Manuals for OVPI, and manuals for the reporting solutions that run on OVPI, can be 
downloaded from the following web site:

http://www.hp.com/managementsoftware

Select Support > Product Manuals to reach the Product Manuals Search page. The user guides for 
OVPI are listed under Performance Insight. The user guides for report packs, NNM SPIs, and 
NNM correlators are listed under Reporting and Network Solutions. 

The manuals listed under Reporting and Network Solutions indicate the month and year of 
publication. If a manual is revised and reposted, the date of publication will change even if the 
software version number does not change. Since we post revised manuals on a regular basis, 
you should search this site for updates before using an older, outdated manual.
13



Sources for Additional Information
14



Chapter 2
The Upgrade Install

This chapter covers the following topics:

• Guidelines for a smooth upgrade

• Upgrading to Frame Relay 4.0

• Removing Frame Relay 4.0

Guidelines for a Smooth Upgrade

When you insert the RNS 7.0 CD, launch the package extraction interface, and select OVPI 
components for extraction, the install script extracts every OVPI package from the RNS CD 
and copies the results to the Packages directory on your system. After the extraction process 
finishes, the install script prompts you to launch Performance Insight and start Package 
Manager. Before running Package Manager, review the following guidelines.

Software Prerequisites

Frame Relay 4.0 requires OVPI 5.0 and all available service packs for OVPI 5.0. Following is a 
list of the package-level prerequisites:

• Common Property Tables 3.0 or higher

• Interface Reporting Report Pack 4.0 or higher

• At least one of the following datapipes:

— Frame Relay CPE Datapipe (FRSCPE_Datapipe)

— Ascend Frame Relay Datapipe

— Newbridge Frame Relay Datapipe

— Stratacom Frame Relay Datapipe

Common Property Tables

If you are running Common Property Tables 2.2, upgrade to version 3.0. If you are running 
version 3.0, you have the option of upgrading to version 3.5. Upgrade Common Property 
Tables before upgrading the Frame Relay Report Pack. 
15



Guidelines for a Smooth Upgrade
Installing one or both upgrade packages for Common Property Tables is easy, however, do not 
install other packages at the same time. Install the upgrade package for Common Property 
Tables and only the upgrade package for Common Property Tables. 

If you need help installing the upgrade, or if you want to know more about how this package 
operates, refer to the Common Property Tables 3.5 User Guide. 

Polling Policies for Remote Pollers

Existing datapipes cannot be upgraded. First remove the existing datapipe, then install the 
latest version of that datapipe. When you uninstall an existing datapipe, the following 
information will be lost:

• Polling policies for remote pollers

• Multi-poller policies 

• Customized polling groups 

You can export existing polling policy configurations and customized polling groups by using 
the collection_manager and group_manager commands. 

Exporting Polling Policy Configurations

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export exiting policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst

Windows: As Administrator, launch a command window. Navigate to the OVPI install 
directory and execute the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Customized Polling Groups

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 

UNIX: As user trendadm, execute the following command: 

cd $DPIPE_HOME

./bin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the OVPI install 
directory and execute the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups
16



Chapter 2
Custom Data Table Views

If you created custom data table views using existing property table views, drop the custom 
data table views now, prior to upgrading the report pack. Dropping custom table views will 
not lose data. 

Distributed Environments

Package installation in a distributed environment is more complicated than package 
installation on a stand-alone server. Follow these steps:

• Make sure every server is running OVPI 5.0 and all available service packs.

• Disable trendcopy on the central server.

• Upgrade the report pack on the central server.

• At each satellite server:

— Remove existing datapipes

— Install the upgrade package for the report pack

— Install new datapipes

• Re-enable trendcopy of the central server.

When you installed Frame Relay 3.0, you used DS EDIT to set up connections with satellite 
server databases. If you recently upgraded from OVPI 4.6 to OVPI 5.0, you must repeat the 
following tasks:

• Set up connections with satellite server databases 

• Configure trendcopy pull commands

You must repeat these steps because the technique for setting up connections with satellite 
server databases changed in OVPI 5.0. For details, see Chapter 4, Distributed Systems.

Upgrading to Frame Relay 4.0

Perform the following tasks to upgrade to Frame Relay 4.0:

• Task 1: Stop OVPI Timer and extract packages from the RNS CD

• Task 2: Upgrade to Common Property Tables 3.0 or higher

• Task 3: Remove existing datapipes

• Task 4: Upgrade to Frame Relay 4.0

• Task 5: Install one or more datapipes; restart OVPI Timer

Task 1: Stop OVPI Timer and extract packages from the RNS CD

1 Log in to the system. On UNIX® systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:
17



Upgrading to Frame Relay 4.0
a Select Control Panel > Administrative Tools > Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the RNS 7.0 CD. 

Windows: The Main Menu automatically displays. 

UNIX: 

a Mount the CD (if the CD does not mount automatically).

b Navigate to the top level directory on the CD.

c Run ./setup

4 Type 1 in the choice field and press Enter. The install script displays a percentage 
complete bar. When the copy is complete, the install script starts Package Manager. The 
Package Manager welcome window opens.

Task 2: Upgrade to Common Property Tables 3.0

The RMON2 Traffic Profiling Report Pack requires Common Property Tables 3.0. Upgrade to 
Common Property Tables 3.0 by starting Package Manager and installing the 2.2-to-3.0 
upgrade package. When the install finishes, click Done to return to the Management Console.

Task 3: Remove existing datapipes 

1 Start Package Manager. The Package Manager Welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Uninstall.

4 Click Next. The Report Undeployment window opens.

5 Click Next. The Package Selection window opens.

6 Click the check box next to each datapipe that you want to remove.

7 Click Next. The Selection Summary window opens.

8 Click Uninstall. The Progress window opens. When removal is complete, a package removal 
complete message appears.

9 Click Done to return to the Management Console.

Task 4: Upgrade to Frame Relay 4.0

1 Start Package Manager. The Package Manager Welcome window opens.

2 Click Next. The Package Location window opens.

If you are not currently running any version of Common Property Tables, skip 
this task.
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3 Click Install. Approve the default installation directory or select a different directory if 
necessary. 

4 Click Next. The Report Deployment window opens. Type your username and password for 
the OVPI Application Server. 

5 Click Next. The Package Selection window opens. Click the check box for the upgrade 
package you require. Your options are: 

If you are currently running version 2.0 or 2.5, you must perform the upgrade procedure 
twice: once to upgrade to version 3.0, and a second time to upgrade to version 4.0.

6 Click Next. The Type Discovery window opens. Accept the default and click Next. The 
Selection Summary window opens. 

7 Click Install. The Installation Progress window opens. When installation finishes, a 
package install complete message appears.

8 Click Done to return to the Management Console. 

Task 5: Install one or more new datapipes and restart OVPI Timer 

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Install.

3 Click Next. The Report Deployment window opens. Type your username and password for 
the OVPI Application Server. 

4 Click Next. The Package Selection window opens. Click the check box next to the name of 
each datapipe that you want to install.

5 Click Next. The Type Discovery window opens. Disable the default and click Next. The 
Selection Summary window opens. 

6 Click Install. The Installation Progress window opens. When installation finishes, a 
package install complete message appears.

7 Click Done to return to the Management Console. 

8 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer start

— Sun: sh /etc/init.d/ovpi_timer start

Existing Installation Upgrade Package To Use Finished Installation

Frame Relay 2.0 UPGRADE_FRS_2.x_to_3.0 Frame Relay 3.0

Frame Relay 2.5 UPGRADE_FRS_2.x_to_3.0 Frame Relay 3.0

Frame Relay 3.0 UPGRADE_FRS_3.x_to_4.0 Frame Relay 4.0
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Post-Upgrade Steps
Post-Upgrade Steps

Reconfigure any polling policies and customized group definitions that need to be restored. Do 
not re-import the configurations you exported. Because the old datapipe may be incompatible 
with the new datapipe you just installed, re-importing the configurations you exported could 
lead to data corruption. 

If, before upgrading, you dropped any customized data table views that were based on existing 
report pack property table views, you can recreate those custom views now.
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Chapter 3
The New Install

This chapter covers the following topics:

• Guidelines for a smooth installation

• Installing Frame Relay 4.0

• Removing Frame Relay 4.0

Guidelines for a Smooth Installation

Each reporting solution that runs on OVPI consists of a report pack and one datapipe, or a 
report pack and multiple datapipes. By installing the datapipe you configure OVPI to collect a 
specific type of performance data at a specific polling interval. By installing the report pack 
you configure OVPI to summarize and aggregate performance data in a specific way. 

When you insert the RNS 7.0 CD, launch the package extraction interface, and select OVPI 
components for extraction, the install script extracts every OVPI package from the CD and 
copies the results to the Packages directory on your system. After the extraction process 
finishes, the install script prompts you to launch Performance Insight and run Package 
Manager. Before running Package Manager, review the following guidelines.

Software Prerequisites

The Frame Relay Report Pack has the following prerequisites:

• OVPI 5.0 and any Service Pack available for OVPI 5.0

• Common Property Tables 3.0 or higher

• Interface Reporting Report Pack 4.5 or higher

• At least one of the following datapipes:

— Frame Relay CPE Datapipe (FRSCPE_Datapipe)

— Ascend Frame Relay Datapipe

— Newbridge Frame Relay Datapipe

— Stratacom Frame Relay Datapipe
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Guidelines for a Smooth Installation
If you are polling Newbridge devices, you must install the Newbridge Preprocessor in addition 
to the packages listed above. If you are polling Stratacom devices, you must install the 
Stratacom Preprocessor in addition to the packages listed above.

Common Property Tables

Version 4.0 of the Frame Relay Report Pack requires Common Property Tables version 3.0 or 
higher. If you are not currently running any version of Common Property Tables, let Package 
Manager install the correct version for you. If you are running Common Property Tables 2.2, 
upgrade to 3.0. If you are currently running Common Property Tables 3.0, you have the option 
of upgrading to version 3.5. Do this before installing the Frame Relay Report Pack.

FrameRelay_Service_Thresholds

If your OVPI server is integrated with your NNM server, you will probably want to install the 
optional thresholds sub-package. The thresholds sub-package contains customized threshold 
settings. When a threshold is breached, the thresholds sub-package responds by taking an 
action. The default action is to send a threshold trap to your NNM server.

You have the option of setting thresholds for rate data only, for rate data and aggregated data, 
or just for aggregated data. If Frame Relay 4.0 will be operating in a distributed environment, 
and you are setting thresholds for rate data only, then each satellite server needs the 
thresholds sub-package. If you want to set thresholds on aggregated data (for example, a 
forecast), then you need to install the thresholds sub-package on the central server, too.

If you select the thresholds sub-package for installation, Package Manager will automatically 
select and install a prerequisite package, the Thresholds Module. The Thresholds Module 
controls the actions that can be taken in response to a threshold condition. For information 
about configuring additional actions, refer to the Thresholds Module 5.0 User Guide. 

Distributed Environments

Package installation in a distributed environment is more complicated than package 
installation on a stand-alone system. Following is an overview of the procedure for installing 
Frame Rely 4.0 in a distributed environment:

• Make sure OVPI 5.0 is installed on the central server and on every satellite server.

• Disable trendcopy on the central server.

• Install the following packages on the central server:

— Common Property Tables; deploy forms

— Interface Reporting; deploy reports

— Frame Relay; deploy reports

• Install the following packages on each satellite server:

— Common Property Tables

— Interface Reporting

— Frame Relay

— FrameRelay_Service_Thresholds (sub-package that comes with Frame Relay)
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— At least one datapipe

• Re-enable trendcopy of the central server.

When you finish the installation, you need to set up connections between the central server 
and each satellite server database, and you need to configure trendcopy pull commands. For 
details, see Chapter 4, Distributed Systems.

Installing Frame Relay 4.0

Perform these tasks to install the Frame Relay Report Pack:

• Task 1: Stop OVPI Timer and extract packages from the RNS CD.

• Task 2: If necessary, upgrade to Common Property Tables 3.0 or higher

• Task 3: Install the report pack and at least one datapipe

• Task 4: Restart OVPI Timer

Task 1: Stop OVPI Timer and extract packages from the RNS CD

1 Log in to the system. On UNIX® systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the RNS 7.0 CD. 

Windows: The Main Menu automatically displays. 

UNIX: 

a Mount the CD (if the CD does not mount automatically).

b Navigate to the top level directory on the CD.

c Run ./setup

4 Type 1 in the choice field and press Enter. 

The install script displays a percentage complete bar. When the copy is complete, the 
install script starts Package Manager. The Package Manager welcome window opens.

Task 2: Upgrade to Common Property Tables 3.0 or higher

The Frame Relay Report Pack requires Common Property Tables 3.0 or higher. If you are 
running an earlier release of Common Property Tables, you must upgrade to version 3.0. 
When you upgrade to version 3.0, do not install other packages at the same time. Install the 
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Installing Frame Relay 4.0
upgrade package for Common Property Tables and only the upgrade package for Common 
Property Tables. If you need help with the upgrade, refer to the Common Property Tables 3.5 
User Guide. 

If you are not running any version of Common Property Tables, skip this task. Package 
Manager will install Common Property Tables for you, automatically.

Task 3: Install Frame Relay 4.0 and at least one datapipe

1 Start Package Manager. The Package Manager Welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory or select a different directory if 
necessary. 

4 Click Next. The Report Deployment window opens. Type your username and password for 
the OVPI Application Server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box for the following packages:

• FrameRelay_Service 4.0

• At least one of the following datapipes:

— Ascend_FR_Datapipe

— FRSCPE_Datapipe

— Newbridge_FR_Datapipe

— Stratacom_FR_Datapipe

• FrameRelay_Service_Thresholds (optional) 

7 Click Next. The Type Discovery window opens. To run Type Discovery immediately after 
package installation, accept the default.

8 Click Next. The Selection Summary window opens. 

9 Click Install. The Installation Progress window opens. When installation is complete, a 
package install complete message appears.

10 Click Done to return to the Management Console. 

Task 4: Restart OVPI Timer

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer start

— Sun: sh /etc/init.d/ovpi_timer start
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Access to Deployed Reports

When you installed Frame Relay, you enabled the Deploy Reports option. As a result, the 
reports in this package (as well as any forms that come with the package) were deployed to 
the OVPI Application Server. Once reports reside on the OVPI Application Server, you have 
two ways to view them:

• OVPI clients

• Web browser

If the client components are installed on your system, you have access to Report Viewer, 
Report Builder, and the Management Console. If the client components are not installed on 
your system, using a web browser is the only way you can view reports.

For more information about the client components, refer to the Performance Insight 
Installation Guide. For more information about the Management Console, including how to 
use the Object/Property Management view to launch reports specific to a selected object, refer 
to the Performance Insight Administration Guide.

Seeing Data in Reports

Some reports populate with data sooner than others. The first report to populate with data is 
the Near Real Time report. You will begin to see data in this report immediately after the first 
data collection completes. Any report that begins with an analysis of yesterday’s performance 
will need at least one full day’s worth of data before results are viewable. Although you will 
begin to see forecast data soon, within a few days, reliable forecast data will not be available 
for about six weeks, when the initial baseline is complete.

New Objects in the Object Model

Any item that appears in a report accompanied by performance data or property information 
is an object. Devices, customers, and locations are objects that belong to OVPI’s default object 
model. When you select an object in the object model, the right side of the Object/Property 
Management window refreshes, showing a list of forms under General Tasks, a list of forms 
under Object Specific Tasks, and a list of reports under Object Specific Reports. 

The object tree changes each time you install a new report pack. For example, installing 
Interface Reporting adds interfaces as objects under devices. In addition to adding new 
objects, some report packs add an entirely new class of objects or services. When this happens, 
the report pack provides a new view. To open the new view, select View > Change View. 

Installing Frame Relay 4.0 adds the following object categories to the object model:

• Frame Relay Interfaces (interfaces that support frame relay circuits)

• Frame Relay PVC Endpoints 
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Removing Frame Relay 4.0

If you remove a report pack, the associated tables and all the data in those tables will be 
deleted. If you want to preserve the data in those tables, archive the data before removing the 
package. Follow these steps to uninstall the Frame Relay Report Pack and any datapipe that 
depends on the report pack:

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services 

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

3 Open the Management Console; from the Tools menu, select Package Manager. The 
Package Manager welcome window opens. 

4 Click Next. The Package Location window opens.

5 Click Uninstall.

6 Click Next. The Report Undeployment window opens. Keep the defaults.

7 Click Next. The Package Selection window opens.

8 Click the check box next to FrameRelay_Service. Any dependent packages will be selected 
automatically.

9 Click Next. The Selection Summary window opens.

10 Click Uninstall. The Progress window opens. When removal is complete, a package removal 
complete message appears.

11 Click Done to return to the Management Console.

12 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer start

— Sun: sh /etc/init.d/ovpi_timer start
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Distributed Systems

This chapter explains how to configure servers in a distributed environment. It reviews 
package installation and covers the following topics:

• Central server configuration

• Satellite server configuration

• System clocks

Package Installation

Before configuring servers, verify that you installed packages correctly. The central server 
must be running the following packages:

• Common Property Tables

• Interface Reporting

• Frame Relay

Each satellite server must be running the following packages:

• Common Property Tables

• Interface Reporting

• Frame Relay

• At least one datapipe

• Frame_Relay_Thresholds, the thresholds sub-package

Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Set up connections with satellite server databases

• Task 2: Configure trendcopy pull commands for hourly data

• Task 3: Configure trendcopy pull commands for rate data (optional)
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Configuring the Central Server
Task 1: Set up connections with satellite server databases

1 Select HP OpenView > Performance Insight > Management Console.

2 Click the Systems icon on the lower left. 

The System/Network Administration pane opens.

3 Right-click the Databases folder. When prompted, select Add OVPI Database. The Add 
Database Wizard opens. 

4 Click Next.

5 Type the hostname and port number for the database you want to add; click Next.

6 Review the Summary. Repeat Steps 4 and 5 for each additional database.

7 Click Finish when you finish adding databases. 

Task 2: Configure trendcopy pull commands for hourly data

1 Open the following file:

$DPIPE_HOME/scripts/FrameRelay-Switch_trendsum_hourly.pro

2 Comment out the pvc and port summaries by adding the comment sign (“#”) before the 
begin and end statements.

3 Uncomment the copy commands in the hourly_copy block.

4 Modify the copy commands as follows:

• Replace SATELLITE_SERVER_1_DATABASE with the satellite server name

• Replace THIS_MACHINE_DATABASE with the central server name

5 If there is more than one satellite server, create and configure new hourly copy commands 
for each additional machine.

Task 3: Configure trendcopy pull commands for rate data (optional)

Copying polled rate data from each satellite server every hour has two side-effects:

• The amount of traffic between satellite servers and the central server increases

• The load on the central server increases

Follow these steps to configure trendcopy pull commands for rate data:

1 Open the following file:

$DPIPE_HOME/scripts/FrameRelay-Switch_trendsum_hourly.pro

2 Uncomment the copy commands in the rate_copy block

3 Modify the copy commands as follows:

• Replace SATELLITE_SERVER_1_DATABASE with the satellite server name

• Replace THIS_MACHINE_DATABASE with the central server name

4 If you have more than one satellite server, create and configure new hourly copy 
commands for each additional machine. 
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Configuring a Satellite Server

Follow these steps to configure a satellite server.

1 Switch off daily aggregations by commenting out the lines referencing FrameRelay-
Switch_Daily.pro in the $DPIPE_HOME/lib/trendtimer.sched file.

2 Modify the FameRelay-Switch_Hourly.pro trendtimer entry in the $DPIPE_HOME/
lib/trendtimer.sched file. By default, this process starts at 40 minutes after the hour. 
To make sure the satellite server completes hourly summarizations before the central 
server begins hourly summarizations, change the start time from 1:00+40 to 1:00+25.

3 Configure polling policies for the Frame Relay CPE Datapipe, making sure that each 
network device is polled by one satellite server only.

System Clocks

Make sure that the system clock on each satellite server is synchronized with the system clock 
on the central server. 

Do not perform this procedure if the satellite server is performing local 
reporting or if the thresholds sub-package is not installed on the satellite 
server.
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Chapter 5
Updating Property Values

This chapter covers the following topics:

• Using forms to update properties (including thresholds) for PVCs

• Using a property import file to update properties (including thresholds) for PVCs

If you have lots of properties to update, using the batch-mode approach (the property import 
file) is probably faster and easier. If you have a small number of changes to make, use the 
forms.

Forms are context-sensitive. Your location in the object model determines which PVCs will be 
updated by the form. Depending on where you are in the object model, the form may apply to 
one specific PVC, or to a long list of PVCs. No matter which form you are using, the form will 
display a list of the PVCs you are able to update. To modify one PVC, highlight one PVC in the 
list; to modify multiple PVCs at once, highlight multiple PVCs in the list. 

Using Forms to Update Property Values

When you install Frame Relay 4.0 and deploy reports, you also deploy the following forms:

• Change PVC Endpoint Customer

• Change PVC Endpoint Location

• Change PVC Endpoint Description

• Change PVC Endpoint Configuration

To launch a form, click the Objects icon on the left side of the Management Console. The 
Object/Property Management view opens. The type of object presented depends on which 
Object Manager View is open:

• The Device view (the default view) shows a list of devices

• The Customer view shows a list of customers

• The Location view shows a list of locations 

To change the view, select View > Change View. Use the pop-up window to select a different 
view.

When the type of object you want to update appears, select the specific object you want to 
update. Under Object Specific Tasks you will see a list of forms. To open a form, double-click the 
name of the form.
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Change PVC Customer

Use the Change PVC Customer form to update the customer assigned to one or multiple PVC 
Endpoints. Use the drop down menu to choose a customer. Click Apply to save your changes. 

If you assigned a customer to an interface (using one of the change forms that come with the 
Interface Reporting Report Pack), the PVC endpoints on that interface will inherit the 
customer assigned to the interface. However, if some PVC endpoints already have a different 
customer assigned to them, the customer you assigned to the interface will not be inherited by 
those PVC endpoints.

Change PVC Location

Use the Change PVC Location form to update the location assigned to one or multiple PVC 
Endpoints. Use the drop down menu to choose a location. Click Apply to save your changes. 

If you assigned a location to an interface (using one of the change forms that come with the 
Interface Reporting Report Pack), the PVC endpoints on that interface will inherit the 
location assigned to the interface. However, if some PVC endpoints already have a different 
location assigned to them, the location you assigned to the interface will not be inherited by 
those PVC endpoints.
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Change PVC Description

Use the Change PVC Description form to update the description of one or multiple PVC 
Endpoints. When the form opens, type your new description in the text entry box. To save 
your changes, click Apply.
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Change PVC Configuration

Use the Change PVC Configuration form to update the following property settings for a single 
PVC endpoint:

• Description

• CIR

• PVC Id

• Customer

• Location

• Allowable DE In Deviation (deviation from yesterday’s average)

• Allowable DE Out Deviation (deviation from yesterday’s average)

• FECN% Threshold

• BECN% Threshold

To save your changes, click Apply.
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Using an Import File to Update Property Values

The same properties you can modify using one of the change forms described in this chapter 
can also be modified using a property import file. You can create this file from scratch, or you 
can export existing property data from OVPI. If you export existing property values from 
OVPI, the file exported from OVPI will be properly formatted. 

Utilization for PVC endpoints cannot be calculated unless CIR values are known. Likewise, 
port utilization cannot be calculated unless ifSpeed is known. If you are collecting these 
values from network elements, and if the values you are collecting are correct, you do not need 
to import correct values. If you are not collecting these values, or if the values you are 
collecting are incorrect, you must import correct values. Use the PVC Configuration Problems 
report to verify whether CIR and PVC Id have been set for all PVC endpoints.

Exporting Property Data from OVPI

If you want to export existing property values from OVPI, follow these steps:

1 Navigate to the DPIPE_HOME/scripts directory.

2 Type: trend_proc -f FrameRelay-Switch_exportdata.pro

This command calls an OVPI process that generates a tab-delimited flat file and, if the 
default SourceDirectory has not been changed, stores it in the PropertyData directory 
under FrameRelay_Switch.ap. The tab-delimited flat file has the following name:

FrameRelay_Switch_PVC_Property.dat.<timestamp>

3 Edit the tab-delimited file, adding new values or correcting incorrect values.

4 Import the file you just edited.

The export step can take place whenever you want, and as often as you want. 

Importing Property Data into OVPI

The import step is actually a scheduled process that executes automatically. It works the 
same way whether you are working with a file you created yourself, or a file that was exported 
from OVPI and then edited. 

If you want to let the import process run automatically, just make sure that your property 
import file is stored where OVPI expects to find it. If the default has not been changed, the 
path to the SourceDirectory is:

{DPIPE_HOME}/data/PropertyData/

OVPI uses a .teel file in the DPIPE_HOME/lib directory to locate the property import file. The 
name of the TEEL file is FrameRelay_Switch_PVC_Property.teel.

The TEEL file must provide the correct SourceDirectory path. The SourceDirectory path may 
have been changed after the Frame Relay Report Pack was installed.

To run the import process manually, ahead of the scheduled import, do the following:

1 Navigate to the DPIPE_HOME/scripts directory.

2 Type: trend_proc -f FrameRelay-Switch_importdata.pro
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Add a New Row or Modify an Existing Row?

If you intend to modify an existing entry in a property table, the first three columns in the 
import file—Node name, Port and Dlci—must match the values of a row in the property table. 
For example, if your PVC property file includes Node Name = router1; Port value = 1; Dlci = 
23, then there must be an exact match with those values in the KV_frswitch_pvc property 
table. Whenever there is no match between a row in your file and a row in the property table, 
your property import file will add a new row to the property table. 

How to Format the PVC Property Import File

If you create your own file, you have to either generate the file automatically from a network 
provisioning database, or build the file from scratch using a spreadsheet program. If you 
create your own tab-delimited file, obey these rules:

• Use the formats described below.

• Use all the columns shown in the file format tables.

• Use the columns in the same order. 

• Do not use quotation marks.

• If a cust_id value is already in use for a different customer_name, the existing 
customer_name will not be modified to that which is included in the import file. cust_id is 
the unique field that binds elements to customers.

• If a location_id value is already in use for a different location_name, the existing 
location_name will not be modified to that which is included in the import file. location_id 
is the unique field that binds elements to locations.

• node_name, port, and Dlci columns are the unique identifiers of the property table and 
must contain the same values that exist on the polled PVC.

• If you use a spreadsheet application, export the data from the spreadsheet back into a 
tab-delimited file when you finish. 

• If you have a previously generated PVC import file from a Frame Relay version 2.0 
installation, you may use it for your current report pack; the import mechanism will 
convert it to the new format and add the extra columns required. 

The following table describes the format of the PVC property import file.

Node Name Description

Node name The device name for the PVC.
Example: ‘router1’

Port The port name for the PVC. Often the ifIndex value, or the 
unique name of the interface.
Example: ‘101’ or ‘Serial0/1’.
You may refer to an interface by the ifIndex during import if you 
do not know the unique identifier being used by the application 
for re-indexing purposes; however, the system will always use the 
unique name for the export procedure.
37



Using an Import File to Update Property Values
Dlci The numerical Dlci for this PVC endpoint.
Example: ‘123’

CIR The Committed Information Rate in bits/second
The report pack requires this value. Some devices provide it 
directly from the network. Check the PVC Configuration 
Problems report to see if any are not set.
Example ‘64000’

RevCIR Reverse Committed Information Rate in bits/second.
Example ‘64000’
Not used in default reports.

cust_id Unique integer value for each customer name.
Reserved values include -2 and -1.
Value should always be greater than 0.
Example: ‘30’

pvc_id Unique integer value for a pair of PVC endpoints.
Used to associate PVC endpoints together. Check the PVC 
Configuration Problems report to see if any are not set. The 
default value of -2 indicates that it has not been set.
Example: ‘55’

location_name Location name associated with location_id value.
Example “North London”.
If the associated location_id already exists with a different 
location_name then this value will be discarded. Use the 
Common Properties package to update location_name / 
location_id value pairs.

customer_name Customer name associated with cust_id value.
Example “Large Corp 1”.
If associated cust_id already exists with a different 
customer_name then this value will be discarded. Use the 
Common Properties package to update customer_name / cust_id 
value pairs.

dsi_descr A description for the PVC endpoint
Example: “Service Level 1” or
“Failover PVC”

FECN Percent The percentage of packets which can be marked FECN; if this 
percentage is exceeded, a threshold event is generated.

BECN Percent The percentage of packets which can be marked BECN; if this 
percentage is exceeded, a threshold event is generated.

Node Name Description
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DE In Deviance The percentage deviation of packets above yesterday’s average 
DE In packet ratio which is considered within normal limits. A 
ratio of in packets marked DE above the average value yesterday 
+ this percentage will generate a threshold event.

DE Out Deviance The percentage deviation of packets above yesterday’s average 
DE Out packet ratio which is considered within normal limits. A 
ratio of out packets marked DE above the average value 
yesterday + this percentage will generate a threshold event.

Node Name Description
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Chapter 6
PVC Endpoint QuickView

The PVC Endpoint QuickView, and the Snapshot version of the same report, identifies PVCs 
with high utilization. Use this report to spot PVCs with high utilization and to find out 
whether utilization is primarily egress or primarily ingress. In addition, this report shows 
how utilization relates to congestion notification and frame types.

There are NRT, daily, and monthly versions of this report. See below for a sample of the Daily 
PVC Endpoint QuickView. The selection table ranks PVCs by utilization and provides values 
for:

• Ingress utilization

• Egress utilization

• Peak ingress utilization

• Peak egress utilization

• Busiest ingress hour

• Busiest egress hour

The hourly graph below the selection table compares: 

• Average ingress utilization to peak ingress utilization

• Average egress utilization to peak egress utilization

The next hourly graph looks at congestion and frame types. Use this graph to compare:

• Average percent of ingress FECN frames to peak percent of FECN frames

• Average percent of ingress BECN frames to peak percent of BECN frames

• Average percent of egress FECN frames to peak percent of FECN frames

• Average percent of egress BECN frames to peak percent of BECN frames

• Average percent of ingress DE frames to peak percent of ingress DE frames

• Average percent of egress DE frames to peak percent of egress DE frames

The Grade of Service bar chart provides an overall score for each hour of the day. The overall 
score combines utilization, frame types, and congestion. The frequency distribution pie charts 
indicate how yesterday’s activity breaks down in terms of the percentage of samples that fall 
into various ranges of utilization.
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Chapter 7
Port NRT QuickView

Port QuickView and Port Snapshot reports are available in three time ranges:

• Daily — showing hourly statistics for the previous day

• Monthly — showing daily statistics for the previous month

• Near Real Time — showing averages compiled over the previous six hours.

Port QuickView and Snapshot reports focus on utilization, discards and errors. The selection 
table at the top performs a ranking function, sorting ports by utilization, highest to lowest. In 
the NRT version of the report (see below), the top selection table provides averages for sample 
data collected during the previous 6 hours. For each port in the table, you can see:

• In utilization

• Out utilization

• Percentage of in errors

• Percentage of out errors

• Percentage of in discards

• Percentage of out discards

The first graph below the selection table compares in utilization to out utilization. The next 
graph to the right looks at errors and discards. Use the graph on the right to compare in 
errors to out errors, and in discards to out discards.

The bottom graph provides an hourly grade of service score for ingress an egress. The score 
combines:

• Utilization

• Errors

• Discards

Use this graph to see when service moved from the good range into the warning range.
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Chapter 8
Port Executive Summary

The Port Executive Summary report conveys a clear picture of utilization on a customer-by-
customer basis. This report aggregates data at the customer level, providing monthly, daily 
and hourly coverage of volume and error counts. What you will not find in this report are 
statistics for specific ports. 

The Port Executive Summary contains one line graph and the following bar charts:

• Monthly volume for all ports — total volume both in and out for all ports associated with 
this customer aggregated for monthly periods.

• Monthly error count for all ports — total error counts both in and out for all ports 
associated with this customer aggregated for monthly periods.

• Daily volume for all ports — total volume both in and out for all ports associated with this 
customer aggregated for daily periods.

• Daily error counts for all ports — total error counts both in and out for all ports associated 
with this customer aggregated for daily periods.

• Hourly volume for all ports — total volume both in and out for all ports associated with 
this customer aggregated for hourly periods.

• Hourly error counts for all ports — total error counts both in and out for all ports 
associated with this customer aggregated for hourly periods.

As explained in Chapter 4, Package Configuration, you have two ways of assigning a customer 
to a PVC:

• By importing the customer name as property data

• By using a change form

If a customer is assigned to the parent object of a PVC, the change will trickle down to the 
PVC level, but only if customers have not been set yet. For example, assume a device has 10 
interfaces, and each interface has 2 PVCs on it. If you assign Customer A to PVC 1 on 
Interface 1 and Customer B to the device itself, the results we be as follows: Every PVC on the 
device will belong to Customer B except PVC 1 on Interface 1.

The total of in traffic and out traffic may reflect double counting of frames 
when the in and out ports are associated with the same customer.
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Chapter 9
PVC Endpoint Availability

The availability report allows you to focus on PVCs and ports that have been unavailable for 
any reason. In this context, an unavailable PVC is a PVC that is out of operation. Scheduled 
maintenance as well as failures will take ports and PVCs out of operation.

Availability is measured as a percentage of time over the time period that the port or PVC was 
considered to be operational—based on metrics such as ifOperStatus, sysUpTime, 
ifLastChange, and Circuit State—on the device.

The selection tables list PVC endpoints that had less than 100% availability over the day or 
month, while the hourly and daily bar graphs illustrate when the problems happened and for 
how long. Each bar in the hourly chart represents one hour in a 24 hour period. Each bar in 
the daily chart represents one day in the previous month.
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Chapter 10
PVC Endpoint Top Ten

There are two Top Ten reports, one for ports and one for PVCs. Each provides a list of the top 
ten elements sorted by average utilization over the time period. The daily section of the report 
looks at statistics for the previous day; the monthly section looks at statistics for the previous 
calendar month.

The first selection table in the PVC Endpoint report looks at average and peak utilization 
levels for yesterday. It provides a list, ranked in descending order, of the ten PVC endpoints 
that reported highest average utilization in either direction, In or Out. In addition to listing 
the PVC endpoint and CIR, this table indicates utilization values for:

• Average In

• Average Out

• Peak In

• Peak Out

Selecting an endpoint from the list displays additional information about the device itself and 
the customer and locations associated with the PVC endpoint. 
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Chapter 11
PVC Endpoint Forecast

The PVC Endpoint Forecast focuses on growth rates. The growth rate for utilization is 
calculated by projecting utilization 30 days into the future and dividing the increase by the 
current baseline average for that day of the week. The higher the difference between the 
current average and the projected value, the greater the rate of growth. Use this report to 
identify problems long before they become critical.

Each row in the selection table describes one PVC endpoint. The endpoints are sorted in 
descending order by rate of growth. In addition to listing endpoints in growth-rate order, this 
table indicates:

• Day of week

• Projected in utilization 30 days into the future

• Baseline utilization

• Projected out utilization 30 days into the future

• In ratio of growth

• Out ratio of growth

When you highlight an endpoint in the selection table, the following data appears in the 
tabbed area.

• Basic: Compares in and out average utilization for the day to the busy hour utilization for 
the day.

• In Util Standard: Compares IN utilization to median IN utilization. The tab shows the 
baseline, the median, baseline utilization -1 standard deviation, and baseline utilization 
+1 standard deviation.

• Out Util Standard: Compares OUT utilization to median OUT utilization. The tab shows 
the baseline, the median, baseline utilization -1 standard deviation, and baseline 
utilization +1 standard deviation.

• In Util Advanced: Compares baseline IN utilization to forecasted IN utilization 30, 60 and 
90 day into the future. The date at the bottom of the tab represents the start date that the 
forecast calculation data is taken from.

• Out Util Advanced: Compares baseline OUT utilization to forecasted OUT utilization 30, 
60, and 90 days into the future. The date at the bottom of the tab represents the start date 
that the forecast calculation data is taken from.
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Chapter 12
PVC Configuration Problems

The PVC Configuration Problems report provides an inventory of:

• PVC Endpoints with no CIR setting

• PVC Endpoints with no PVC Id setting

Invalid CIR Settings

Many Frame Relay reports calculate utilization. These calculations rely on valid CIR values. 
If the CIR value is not valid, the calculation will fail. If the RFC1315 MIB table or the Cisco 
Frame Relay MIB table provides a CIR of 0 bits per second, errors will occur when OVPI 
attempts to calculate utilization. These errors will cause rows of data to disappear from 
selection tables. To avoid this problem, you must re-set the CIR. One of your options is to set 
the CIR equal to the full ifSpeed of the interface that the PVC terminates on. This speed is 
equal to the maximum bandwidth available to the PVC.

If invalid CIR values are being sourced from either the RFC1315 MIB or the Cisco Frame 
Relay MIB, you have to ways to set valid values:

• By editing a property import file, and letting OVPI import the file

• By using a change form

Invalid PVC Id

The PVC Id is an integer value associated with the two ends of a single PVC. When a PVC Id 
for each PVC Endpoint is not available, most reports are not affected, however, the End-to-
End reports will be affected. Populating this field is recommended, but not mandatory.

There are two ways to update PVC Id values:

• By editing a property import file, and letting OVPI import the file

• By using a change form

See Chapter 5, Updating Property Values, for more information about importing property 
information, including CIR and PVC Id.
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Chapter 13
Editing Tables and Graphs

Any table or graph can be viewed in several ways. While the default view is usually adequate, 
you can easily change to a different view. If you are using Report Viewer, right-click the object 
to display a list of view options. If you are using the Web Access Server, follow these steps to 
change the default view of a table or graph:

1 Click Preferences on the links bar.

2 Expand Reports in the navigation frame.

3 Click Viewing.

4 Select the Allow element editing box.

5 Click Apply.

6 Click  (the Edit icon) next to the table or graph. 

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options.

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time.
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View Options for Tables
Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens.
Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 
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View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 

The following table provides details about each option.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a 
spreadsheet.

Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines

Legend Delete or reposition the legend. 

Style See the illustrations below.

Change Max Rows... Same as the table option shown above.

Display Data Table See below.
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View Options for Graphs
Style Options

Select Style to display a list of seven view options for graphs.

Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

Export Element as CSV... Same as the table option shown above.

View in New Frame Opens graph in a Graph Viewer window.

Print Graph Same as the table option shown above.

Option Function
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Chapter 13
To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables.

Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below.
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View Options for Graphs
Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten.

Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers.
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Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day.

If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day. 

Display Data Table

This option changes a graph into a spreadsheet. 
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View Options for Graphs
View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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glossary
Backward Explicit Congestion Notification (BECN)

A specific bit in the header of the frame relay packet; also, a method for preventing a 
congested condition from getting worse. If a node becomes congested, changing the value of 
the BECN bit to 1 signals congestion to the upstream node and attached user devices.

Busy Hour 

The definition varies depending on what is being measured. Busy hour is either a busy hour 
total, or a busy hour average. A busy hour total points to the hour of the day that recorded the 
highest number of events, for example, the highest number of discards or the highest number 
of errors. A busy hour average points to the hour of the day when the average of multiple 
samples was highest (in the case of utilization) or lowest (in the case of throughput). Busy 
hour is a persistent event and should not be confused with peak, which could be very brief. If 
the value for busy hour seems high, keep in mind that actual utilization during the course of 
that hour may have been significantly higher.

Congestion 

The point at which the network cannot keep up with entering traffic and begins flow control. 
The network reaches severe congestion when an increase in the number of retransmissions 
begins to lower actual effective throughput. To recover from this condition, the network 
notifies end devices to reduce traffic. 

Committed Information Rate (CIR) 

The rate at which the ingress interface and the egress interface transfers information to a 
destination under normal conditions.

Data Link Connection Identifier (DLCI)

A number inside the header of a frame relay packet that identifies a virtual circuit 
corresponding to a particular destination. 

DE frames

Number of frames eligible for discard. A DE frame is created when the remote DTE sets the 
DE flag.

Discards

The number of frames that were discarded. Higher level protocols detect discarded frames 
and request a retransmission.
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Discard Eligibility

A specific bit in the header of a frame relay packet; also, a mechanism for identifying which 
frames should be discarded if the network becomes overloaded. When a CPE device or a 
network switch sets the DE bit to 1, the frame is above the Committed Information Rate (CIR) 
and therefore eligible for discard if congestion arises. A frame with a DE set to 1 will be 
discarded before non-discard eligible frames. 

Errors

The number of frames that were discarded because of errors. The following conditions are 
considered errors and will cause the frame to be discarded: (1) the frame was too long, (2) the 
frame was too short, (3) the DLCI value was invalid or unrecognized, (4) a value in the header 
was incorrect.

Forward Explicit Error Notification (FECN)

A specific bit in the header of the frame relay packet; also, a method for preventing a 
congested condition from getting worse. If a node becomes congested, it can set the value of 
the FECN bit to 1, thereby signally congestion to the downstream node and attached user 
devices.

Frame Types

There are three types of frames: unmarked frames, frames marked Discard Eligible (DE), and 
frames marked ODE. Frame types are color-coded. Unmarked frames are green; DE frames 
are amber, and ODE frames are red. Because most switch vendors do not mark frames ODE, 
your reports will not show statistics for red frames unless your switch vendor supports ODE. 

Frequency Distribution

QuickView and Snapshot reports include frequency distribution pie charts that show the 
percentage of samples falling within a specific ingress/egress or in/out utilization range for 
each hour of yesterday, or each day over the course of the last thirty days. The ingress and 
egress ranges for PVC endpoint utilization are:

• 0 - 80%

• 80 - 90%

• 90 - 100%

• > 100%

The in and out ranges for port utilization are:

• 0 - 50%

• 50 - 60%

• 60 -70%

• 70 - 100%
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Grade of Service

Quickview, Snapshot, and Hot Spots include Grade of Service charts. A Grade of Service is a 
ranking derived from a weighted average. The following table explains the grading behind 
scores for PVC endpoints. It shows the metrics the grade is based on, the weighting factor 
assigned to each metric, and the performance parameters for each of four possible grades. 

The following table explains the grading behind scores for ports. It shows the metrics the 
score is based on, the weighting factor assigned to each metric, and the parameters for each of 
four possible grades.

Near Real Time (NRT)

A report containing a rolling average for performance over the last six hours. The most recent 
data in this report was collected by the most recent poll, which probably took place within the 
last 15 minutes. 

Peak

The highest of several samples (typically, the highest of four samples if polling is taking place 
every 15 minutes) recorded over an hour. Each hour produces one peak. 

Port

Any frame relay interface on any network device that supports MIB-II. 

GRADE 
CALCULATION

AVERAGE 
UTILIZATION

AVERAGE 
PERCENT RED 
AND/OR AMBER 
FRAMES

AVERAGE 
PERCENT 
CONGESTION

Weighting 60% 20% 20%

Excellent Range 0 - 80% 0 - 5% 0 - 5%

Good Range 80 - 90% 5 - 7% 5 - 7%

Warning Range 90 - 100% 7 - 10% 7 - 10%

Critical Range Over 100% Over 10% Over 10%

GRADE 
CALCULATION

AVERAGE 
UTILIZATION

AVERAGE 
PERCENT RED 
AND/OR AMBER 
FRAMES

AVERAGE 
PERCENT 
CONGESTION

Weighting 60% 20% 20%

Excellent Range 0 - 50% 0 - 5% 0 - 5%

Good Range 50 - 60% 5 - 7% 5 - 7%

Warning Range 60 - 70% 7 - 10% 7 - 10%

Critical Range Over 70% Over 10% Over 10%
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Permanent Virtual Circuit (PVC)

A fixed path not available on demand or on a call-by-call basis. The location of the beginning 
and the end of the circuit do not change, although the actual path taken through the network 
may vary if automatic rerouting takes place.

PVC Endpoint

The logical end point for a circuit. Typically this is defined by a combination of the device 
name, the MIB-II interface name and the Dlci number.

Utilization

Calculated at a PVC Endpoint by dividing the actual traffic on the circuit by the Committed 
Information Rate. Calculated at the Port or interface level by dividing traffic counts by the 
ifSpeed of the Port.
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